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1 About these operating instructions 

You must read these operating instructions before operating Geocal / 
Geocal XL / Geocal IR (hereinafter referred to as Geocal, unless a 
specific variant is meant) for the first time or before carrying out any 
other work on Geocal. 

Pay particular attention to chapter 2 "General safety regulations". 

1.1 General information 

These instructions are intended to make it easier to get to know Geo-
cal and use it for its intended purpose. 

 NOTE 
 
 All procedures described in this manual regarding the han-
dling of Geocal apply equally to Geocal, Geocal XL and Geo-
cal IR. 
 
 The differences between the individual variants are described 
in chapter 9 "Differences between the Geocal variants". 

 
The operating instructions contain important information on how to 
operate Geocal safely and properly. Observing them will help: 

◼ Avoid dangers 

◼ Reduce repair costs and downtime 

◼ increase the reliability and service life of the product 

 

These instructions must be read and applied by every person who is 
tasked with working on Geocal. 

In addition to these operating instructions, the regulations on accident 
prevention and environmental protection applicable in the country of 
use and at the place of use must also be observed. 
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1.2 Presentation of information 

Structure of instructions 

Instructions for action are divided into: 

◼ Action steps 

◼ Results of the actions 

◼ Application tips for optimal use 

 

Each piece of information is identified by a symbol: 

Icon Meaning 

  

1.   

2.   

3.   

Action steps: These action steps are numbered con-
secutively and must be carried out in the specified or-
der from top to bottom. 

 

✓   Result symbol: The text after this symbol describes the 
result or intermediate result of an action. 

TIP: Application tip: Additional information on optimal use of 
the product. 

Tab. 1.1 Meaning of symbols 

 

Structure of the warnings 

Signal word Use for ... Possible consequences 
if the safety instructions 
are not observed: 

DANGER Personal injury  
(imminent danger) 

Death or serious  
injury! 

WARNING Personal injury  
(potentially dangerous sit-
uation) 

Death or serious  
injury! 

CAUTION Personal injury Slight or minor injuries! 

NOTE Material damage Damage to the device 
and the surrounding area 

Tab. 1.2 Warning levels 

 

 

The warnings are structured as follows: 

◼ Warning sign with signal word corresponding to warning level 
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◼ Type of hazard (description of the hazard) 

◼ Hazard consequences (description of the consequences of the 
hazard) 

◼ Averting danger (measures to prevent danger) 
 

 

 

DANGER! 

Type of hazard 

Consequences of danger 

1. Emergency response 

 

 

Special warnings are provided at the relevant points. They are 
marked with the following symbols. 

 

General danger zone 
This sign warns of personal injury. 

If there is a clear source of danger, it is preceded by one of the follow-
ing symbols. 

 Laser radiation 
This sign warns of visible or invisible laser radiation 

Technical terms and abbreviations used 

 

Abbreviation Meaning 

DOE Diffractive optical element, diffraction grating 

DUT Device under test 

ROI Region of Interest 

Tab. 1.3 Abbreviations used 

 

Warning signs 
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2 General safety regulations 

2.1 Principles 

Before putting the appliance into operation, make sure that the appli-
ance is: 

1. In perfect working condition visually 

2. Securely placed on a plane and level surface 

Before switching on the device, please ensure that there are no opti-
cal instruments/lenses in front of the device that focus the emitted 
light on a single point. 

 CAUTION! 

Visible or invisible laser radiation  
of laser protection class 1M 

Danger to the human eye with refocusing 

Do not look into the beam with optical instruments! 

 
 Important information:  
 Read the manual carefully before using this device. 
 Improper use may result in damage to the device, the device under 
test and/or other components of your setup. Please keep this manual 
in a safe place and pass it on to future users. 

2.2 Intended use 

Geocal is designed to geometrically calibrate camera systems using a 
grid of light points projected from infinity. Geocal provides the hard-
ware basis with which the calibration pattern can be recorded. The 
recorded images are evaluated using the software supplied. The de-
vice may only be operated indoors. 
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2.3 Foreseeable misuse 

1. Operation of Geocal on an inclined or movable surface (risk of 
falling or tipping over) 

 

CAUTION! 

Risk of crushing due to the appliance falling down 

Only place Geocal on stable, level and horizontal surfaces. 

 

2. Take a long look into the optics , or the DOE of the Geocal 

3. Removal of the diffractive optical element (DOE) by the user 

4. Looking into the beam with optical instruments (refocusing the 
laser light on the retina) 

 CAUTION! 

Visible or invisible laser radiation  
of laser protection class 1M 

Danger to the human eye with refocusing 

Do not look into the beam with optical instruments! 

 

5. Open the housing to expose the laser (danger to eyes, impact 
on the environment due to laser radiation) 

6. Dismantling the optics to expose the laser (danger to the 
eyes, impact on the environment due to laser radiation) 

 WARNING! 

Visible or invisible laser radiation of laser protection 
class 3B when the housing is open 

Immediate danger to the human eye 

The housing must not be opened under any circum-
stances! 

 

7. Power supply outside the specification defined by IE (e.g. use 
of an incorrectly set universal power supply unit). 
 
There is no power supply unit included with Geocal. When se-
lecting a power supply unit, please note the requirements be-
low: 



General safety regulations 2 

Issue EN 2024-03     Geocal / Geocal IR / Geocal XL  User Manual  11/48 

Power supply: 

Limit values:   +5 VDC, 4A min.  
recommended:   +5VDC, 25W 

Protective devices: 2x Means Of Patient Protection  
(MOPP, according to IEC 60601) 

Connector plug: DC hollow plug  
2.1mm inner diameter  
5.5mm outer diameter 

Recommended power supply unit: Mean Well GSM40A05-P1J 

2.4 Safety regulations 

General information 

 

CAUTION! 
 
Do not open the device! 
 
The device is maintenance-free and must not be opened by 
the user. 

 CAUTION! 

Visible or invisible laser radiation  
of laser protection class 1M 

Danger to the human eye with refocusing 

Do not look into the beam with optical instruments! 

 WARNING! 

Visible or invisible laser radiation of laser protection 
class 3B when the housing is open 

Immediate danger to the human eye 

The housing must not be opened under any circum-
stances! 

During operation 

Before switching on the device, please ensure that there are no opti-
cal instruments/lenses in front of the device that focus the emitted 
light on a single point. 

 CAUTION! 

Visible or invisible laser radiation  
of laser protection class 1M 
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Danger to the human eye with refocusing 

Do not look into the beam with optical instruments! 

Care, maintenance and inspection work 

The device is maintenance-free. 

Any repairs that may be necessary may only be carried out by Image 
Engineering and specialist personnel appointed by Image Engineer-
ing. 

2.5 Residual risks 

Despite all the measures taken to avoid or mitigate risks, a small re-
sidual risk remains when using Geocal.  
 Therefore, please ensure that you and all other users follow the 
safety instructions in this operating manual. 

 CAUTION! 

Visible or invisible laser radiation  
of laser protection class 1M 

Danger to the human eye with refocusing 

Do not look into the beam with optical instruments! 

2.6 Selection and qualification of personnel 

Geocal may only be operated by persons who have carefully read 
these operating instructions. 
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2.7 Safety signs 

The following warning is attached to the side of the housing of Geocal 
and Geocal XL:  

 

 

The following warning is attached to the side of the Geocal IR hous-
ing: 

 

 

When closed (state of delivery), all variants are laser class 1M prod-

ucts. 

 

WARNING:  

When the housing is opened, these are laser class 3B products. The 

housing must not be opened under any circumstances. 
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3 Scope of delivery of the device 

Geocal is supplied fully assembled. 

The following is included in the scope of delivery: 

• Geocal hardware device 

• The current software version on a USB storage medium 

• USB cable (type B to type A) 

• Acceptance protocol 

• Operating instructions in printed form 

 NOTE  
The desktop power supply is not part of the product and must 
be purchased separately. 

When selecting a power supply unit, observe the require-
ments and recommendations in chapter 4.5 - Interfaces and 
power supply requirements 
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4 Structure and function 

4.1 General overview 

 

 
Fig. 4.1 from left to right - Geocal XL, Geocal, Geocal IR  

1. Sub-assembly 1 - Electronic unit  

2. Sub-assembly 2 - Optical unit 

3rd Sub-assembly 3 - DOE and DOE holder 

4.2 Sub-assembly 1 - Electronic unit 

Module 1 contains all the electronics required for the operation of Ge-
ocal. 
 
 These are 

• Laser diode 

• Laser controller 

• USB interface 

• Power connection socket 
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• Rear indicator light 

• Main switch 

4.3 Sub-assembly 2 - Optical unit 

Sub-assembly 2 is the optics, which is used to expand and collimate 
the laser beam to the exit diameter. 

4.4 Sub-assembly 3 - DOE and DOE holder 

Assembly 3 consists of DOE and DOE holder. The expanded and col-
limated laser beam hits the DOE from the inside. The incident light is 
deflected in a certain way by the finely etched structure of the DOE so 
that the grid of light points required for calibration is generated by 
positive and negative interference. 

4.5 Interfaces and power supply requirements 

Geocal has a USB type B interface and a power connection socket on 
the back of the housing. 

USB interface: 
Currently still without function 

Power connection socket: 
Geocal has a power connection socket for a hollow plug (internal di-
ameter: 2.1mm, external diameter: 5.5mm), e.g. Mean Well type P1J. 

There is no power supply unit included with Geocal. When selecting a 
power supply unit, please note the requirements below: 

Power supply: 
 
Recommended:   +5VDC, 25W 

Protective devices: 2x Means Of Patient Protection  
(MOPP, according to IEC 60601) 

Connector plug: DC hollow plug  
2.1mm inner diameter  
5.5mm outer diameter 

Recommended power supply unit:  Mean Well GSM40A05-P1J 
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 NOTE  
The desktop power supply is not part of the product and 
must be purchased separately. 

When selecting a power supply unit, observe the re-
quirements and recommendations in chapter 4.5 - Inter-
faces and power supply requirements 

 

4.6 Functional diagram / functional sequence 

A brief schematic representation of the use of Geocal is as follows. 

1. Switch on Geocal 

2. Place your camera / DUT on a tripod or similar in front of the 
Geocal 

3. Create one or more images of the point grid generated by Ge-
ocal 

4. Load the created recordings into the Geocal software 

5. Either load one of the standard configuration files stored in the 
installation directory or modify it according to your require-
ments 

6. Perform the detection of the displayed points in the software 

7. Carry out the analysis of the recordings 

8. Save the results as .CSV or .XML 

Further information on creating recordings and using the software can 
be found later in these operating instructions. 
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5 Transportation and storage 

5.1 Transportation 

Requirements for the installation site 

Geocal may only be operated indoors. 
 Place Geocal on a stable, level, non-inclined surface 

To minimize the risk of bumping, Geocal requires a minimum footprint 
of approx. 85 x 25 cm (Geocal XL) or 58 x 15 cm (Geocal / Geocal 
IR). 

 

CAUTION! 

Loss of stability 

Tipping of the appliance due to installation on an inclined or 
movable surface 

Falling of the device due to impact 

Observe the above instructions for commissioning 

 

Transporting the device 

Before transporting Geocal, remove all cables from the device.  
Geocal can be transported by hand over short distances indoors. 
However, always carry Geocal with two hands to prevent the device 
from falling and crushing injuries. 
 

 

CAUTION! 

Falling of the appliance, risk of crushing 

Do not carry the device with one hand and do not lift it by the 
DOE holder!  

Always carry Geocal with two hands or transport it in the case 
supplied. 
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5.2 Storage 

Requirements for the storage location 

• Temperature range: +15 - +35°C 

• No direct, permanent UV radiation 

• Sand and dust-free environment 

• Rel. humidity: max. 75% without condensation 
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6 Installation and commissioning 

6.1 Installation 

Geocal may only be operated indoors. 
Place Geocal on a stable, level, non-inclined surface 

To minimize the risk of bumping, Geocal requires a minimum footprint 
of approx. 85 x 25 cm (Geocal XL) or 58 x 15 cm (Geocal / Geocal 
IR). 

 

CAUTION! 

Loss of stability 

Tipping of the appliance due to installation on an inclined or 
movable surface 

Falling of the device due to impact 

Observe the above instructions for commissioning 

Establish power connection 

Connect Geocal to the mains using a suitable power supply unit and 
a power cable. 

  NOTE 
Impairment of the function or destruction of the  
device by using a power supply unit outside the specifi-
cation 

 

 

 NOTE 
The desktop power supply is not part of the product and 
must be purchased separately. 

When selecting a power supply unit, observe the require-
ments and recommendations in chapter 4.5 - Interfaces 
and power supply requirements 
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6.2 Commissioning 

Once the power supply has been established and the blue control 
LED on the back of the housing lights up, Geocal is ready for opera-
tion. 

The software supplied is only required for analyzing the recordings 
made and not for operating the hardware. 

To put Geocal into operation, press the on/off switch on the back of 
the housing. 

 CAUTION! 

Visible or invisible laser radiation  
of laser protection class 1M 

Danger to the human eye with refocusing 

Do not look into the beam with optical instruments! 

 

6.3 Optional modification for use  
on production lines 

If you want to use Geocal in a production line, we offer the option of 
modifying the device so that the switch no longer needs to be oper-
ated to switch it on and off.  
 After the modification, all you need to do is move the switch to the 
"ON" position. The appliance switches on immediately when it is sup-
plied with power, without having to operate the switch again. 

For more information on this option, please contact Image Engineer-
ing. 
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7 Operating and display elements 

7.1 Control elements on the device 

 
Fig. 7.1 Operating and display elements on Geocal 

1. Main switch 

2. Control LED (blue) 

3. Power connection socket 

4th USB type B interface (still without function) 

5th Cable strain relief (Geocal IR only) 
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8 Operating the device 

8.1 Operate device 

Geocal:  
Geocal is ready for use immediately after switching on. A warm-up 
phase is not required. 

Diffractive optical element (DOE): 
A diffractive optical element (DOE) is used to split the incident light 
beam and create a calibration grating of evenly distributed light spots 
with a wavelength of 633nm (Geocal, Geocal XL) or 935nm (Geocal 
IR). The DOE is attached to the front of the Geocal (visible glass plate 
in round cut-out, see Figure 8.2.1).  

Fig. 8.1.1: DOE 
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Fig. 8.1.2: Dot grid generated by the DOE. The brightest point is the zeroth 
diffraction order and thus the center of the diffraction pattern. 
 

Camera settings: 
Set the camera to manual exposure mode. If manual mode is not 
available, use automatic exposure mode. To achieve optimum re-
sults, the image should be saved in a lossless format. The TIFF for-
mat is recommended, but PNG and JPEG (lossy) are also supported. 
If you convert RAW image data to another format, make sure that the 
image is demosaiced or the Bayer pattern is removed. 

The autofocus must be switched off. As Geocal uses a collimated 
beam of light that comes practically from infinity, the suitable focus 
distance is infinity. When focusing manually, make sure that the cam-
era is focused on the light points. 

Exposure program Manual 

Aperture number No specification 

ISO value Smallest possible (e.g. 50, 100) 

Autofocus OFF 
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file format TIFF recommended, PNG, BMP 
and JPG supported 

 
 
Camera position and suitable lenses: 
Place the camera in front of the DOE in the circular opening on the 
front of the Geocal. 

The camera can be placed directly in front of the DOE; a minimum 
distance is not required (see Figure 8.2.3 below). The optical axis of 
the lens should be aligned approximately perpendicular to the DOE. 
This is achieved by aligning the zeroth diffraction order, the brightest 
point in the center of the grating, with the center of the image. See 
Figure 8.2.4 and 8.2.5 for reference. Make sure that the dot grid co-
vers the entire image and that the edge of the DOE is not visible. 

Fig. 8.2.4: Good alignment of the camera, zero order in the center 
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Fig. 8.2.5: Poor alignment of the camera, zero order not in the center 

Fig.8.2.6: Distance between camera and geocal 

The top of Geocal and the top of the camera must have the same ori-
entation, as shown in Figure 8.2.6. A rotation of the camera around 
the optical axis of approx. +/- 2° is tolerated. No further alignment 
steps are required. The parallel shift of the camera in relation to the 
DOE has no influence on the position of the light points. The camera 
rotation in relation to the DOE is part of the calibration and is deter-
mined during the process and output as part of the result. 

The front lens of the objective must not exceed a diameter of 77 mm 
for Geocal/Geocal IR or 155 mm for Geocal XL in order to capture the 
dot grid in full format. 

  NOTE 
Be careful when positioning the camera. The DOE is 
made of glass and is only 1.5 mm thick.  
 Make sure that the calibration is carried out in a dark 
environment to avoid stray light, reflections and similar 
disturbing factors. 
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Exposure: 
For best results, the exposure should be selected so that the individ-
ual light points are not saturated (i.e. no white pixels or a minimum 
number of white pixels in the center of each point), with the exception 
of the zeroth order. The zeroth order will always be significantly 
brighter than the points surrounding it. See Figure 8.2.7 below for an 
example. 

Fig. 8.2.7: Suitable exposure 

Fig. 8.2.8: Exposure too bright (red background, larger, saturated dots) 
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Depending on the camera, you may encounter different problems: 

 

The exposure time of my camera cannot be set short enough to 
avoid saturation.  

Possible solutions: 

- Set the ISO value to the lowest available value. 

- Reduce the aperture if possible 

- If the exposure is still too long, you can use an ND filter to re-
duce the amount of light reaching the image sensor. 

  NOTE 
The introduction of any additional optical element into 
the beam path will have an influence on the calibration 
result and must be taken into account by the user. 

 

 

The intensity decreases too much towards the edges of the im-
age and dots are no longer visible.  

This problem can occur with ultra-wide-angle lenses. If the images 
cannot be analyzed properly, try the following: 

Create an HDR image by taking several images of the dot grid with 
different exposure times (do not change the aperture settings in this 
case) and combine them to create an image with a high dynamic 
range to achieve a more or less even exposure across the entire sen-
sor. Do not change the orientation of the camera between shots, as 
the dots would no longer be aligned with each other if several shots 
were taken. 

8.2 Switch off the device 

Switch Geocal off using the toggle switch on the back of the housing. 

If Geocal is taken out of operation for a longer period of time, discon-
nect the device from the mains. 
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9 Differences between the Geocal variants 

Physical size: 
The main difference between Geocal / Geocal IR and Geocal XL is 
the size of the diffractive optical element (DOE) that creates the dot 
pattern.   
While the standard Geocal / Geocal IR has a usable diameter of 77 
mm, Geocal XL offers a functional diameter of 155 mm. 
 
Laser wavelength: The difference between Geocal / Geocal  
XL and Geocal IR lies in the wavelength of the laser diode used.  
 Geocal and Geocal XL use light with a wavelength of 633nm and are 
used for the calibration of cameras that work with the VIS spectrum of 
light (380-780nm). 
 Geocal IR uses light with a wavelength of 935nm and is used for the 
calibration of cameras that work with the NIR spectrum of light. 

9.1 Why a larger version of the Geocal? 

A larger DOE can be helpful in two cases: if the device under test 
(DUT) either has a lens with a front element that is too large or if it 
cannot be placed directly in front of the DOE.  

Large lens diameters:  
Large lens diameters (e.g. for video special effects applications, 
AR/VR imaging, aerial photography, etc.) can be the reason why the 
dot grid cannot be recorded to fill the format, as the frame of the DOE 
is simply visible in the recordings and shadows the light of the Geo-
cal. In this case, we recommend the Geocal XL, whose DOE has 
twice the diameter of the standard version (155mm instead of 77mm). 

As long as there is no shading, the point grid shown for both Geocal 
variants is the same. The size of the DOE is irrelevant. Therefore, 
Geocal XL makes it possible to calibrate any camera up to a lens di-
ameter of 155mm* and guarantee the same accuracy as the standard 
version. 
 
 
 
 
 
 

 

 

 
 
 *within the specifications of the data sheet 
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Longer distances: 
Another reason for a larger DOE is, for example, if the windshield of a 
car is between the geocal and the DUT.  As mentioned  
in chapter 8.1, subsection "Camera position and suitable lenses", the 
generated dot grid must cover the entire camera sensor to ensure re-
liable calibration. 

Fig. 9.1: Purpose of a Geocal XL with large DOE 

 
As shown in Figure 9.1, the angle of the windshield prevents the 
standard geocal from being placed close enough to the camera to 
provide  
a full-frame image of the standard DOE. This shooting situation would 
result in a less accurate and less reliable calibration. 

9.2 Why an infrared version of the Geocal? 

Calibration of infrared cameras is important for certain applications to 
ensure that the data they capture is accurate and reliable. Examples: 

Advanced driver assistance systems (ADAS): Infrared cameras are 
used in advanced driver assistance systems (ADAS) to monitor the 
vehicle's surroundings and detect potential hazards. Calibrated infra-
red cameras ensure that the data captured is precise, enabling accu-
rate detection of pedestrians, vehicles and obstacles. This allows 
ADAS functions such as collision warning, lane departure warning 
and adaptive cruise control to work more effectively and help improve 
vehicle safety. 

Building and construction inspection: Infrared cameras are used in 
building and construction inspection to identify moisture damage and 
other structural problems. Calibrated infrared cameras ensure that the 
images and data captured are accurate, allowing inspectors to recom-
mend appropriate repair measures. 
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10 Operating software 

With the GEOCAL software, you can calibrate your camera system in 
seconds. 

The results can be saved as CSV or XML files. 

10.1 Installing the Geocal software 

• Run the Geocal installer and follow the instructions 

✓ The Geocal software is now ready for use. 

 

10.2 Configuration file (XML format) 

For Geocal/Geocal XL (light with a wavelength of 633nm) and Geocal 
IR (light with a wavelength of 935nm), four standard configuration 
files in XML format are supplied with the software, which are precon-
figured for the respective light wavelength of the Geocal variant. 
If your calibration procedure does not require any special settings, 
you can use one of the four configuration files for the desired distor-
tion model.  
 You can change these files by copying them from the installation lo-
cation:  
 
 C:\Program Files\Image Engineering\GEOCAL 1.x.x\configuration 
 
 to a user-defined folder, changing them and then loading them into 
the software for use. 

Loading a configuration file: 

Click on File → Load configuration (Ctrl+C) → navigate to the folder 
containing the file → select the file and click on "Open". 

Explanation of the parameters from the configuration file: 

Device Parameter: 

• Wavelength  
This parameter describes the wavelength of the built-in laser. 

• Grating constant 
This parameter describes the grating constant of the built-in 
DOE. 
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Detection Parameters: 

• UnusedImageBorder 
This parameter is used to define a detection margin. It can 
happen that points at the edge of the image cannot be recog-
nized correctly. You can use this parameter to ignore a de-
fined border area. 

• RadiusFilterForDetectedPoints 
This parameter is used to define a relative radius (0.0 ... 1.0) 
from the center of the image to the corners. Detected points 
that lie outside the relative radius are ignored during the anal-
ysis. The value 1.0 means that no point is omitted, a value of 
0.8 would exclude all points outside a radius of 80% of the di-
agonal from the center of the image to the corner. 

 
 
Control Parameters: 
 

• MinF 
This parameter describes the stop strategy, at which optimiza-
tion value the analysis is stopped (0.0...10.0 - default: 1.0)  
The smaller the value, the more accurate the analysis be-
comes, but the analysis time also increases. 

• MinDelta 
This parameter describes a further stop strategy. If the change 
in the optimization value between two iterations is smaller 
than the delta, the analysis is stopped (0.0...10.0 - default: 1e-
7).  
 The smaller the value, the more accurate the analysis be-
comes, but the analysis time also increases. 

• Objective 
This parameter defines the objective function to be used dur-
ing optimization. You can choose between CARTESIAN, 
POLAR, POLAR2 and CONSTRAINED.  CARTESIAN and 
POLAR use a cost function that minimizes the MSE (Mean 
Square Error) between the estimated and detected points. 
They are calculated slightly differently, but should perform the 
same. The difference is that the MSE in the case of 
CARTESIAN is the average error in Delta X and Delta Y. In 
POLAR, the RMSE is given as the average error in the Euclid-
ean distance between the estimated point and the detected 
point. POLAR2 performs a two-stage optimization, where first 
an optimization is performed to minimize the error with respect 
to the square of the MSE.  This is followed by a second opti-
mization to minimize the MSE.  This can lead to faster conver-
gence and a lower MSE. The CONSTRAINED option is cur-
rently a beta option and is still being evaluated. If this option is 
selected, constraints are imposed on the values to be opti-
mized to ensure that a feasible solution is determined. 
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• Focal Estimate 
This parameter specifies how the focal length estimation pro-
cess is to be used.  If Use="false" is specified in this parame-
ter, the focal length is not pre-estimated.  Instead, the esti-
mate is determined during the primary optimization.  If 
Use="true", then there are two options to which this parameter 
can be set.  One is FREEZE.  In this case, the values deter-
mined in the focal length estimation phase are fixed and may 
not be changed in the primary optimization.  If the value is set 
to ADJUST, the values determined during the focal length es-
timation can vary during the primary optimization.  The initial 
values for the focal length correspond to those determined 
during the estimation. 

 
Distortion Models: 
 

• Model 
This parameter can be used to select the model to be used. 
The following models are currently implemented: 

o EVEN_BROWN_MODEL 
o FISHEYE_MODEL 
o CUSTOM_MODEL_2 (Division Model) 

 
Focal estimation parameters: 

These parameters are used to control an optimizer that estimates the 

focal lengths before the primary optimization process.  They are only 

valid if FocalEstimate Use="true" is specified in the ControlParame-

ters. 

• AngleSearch 

The +/- range in degrees is specified here, which is searched 
for when determining the camera rotation in the focal estima-
tion phase.   

• CropSize 

The middle part of the image that is used to determine the fo-
cal point estimate is specified here.  This should be a power of 
2. 
 
 

• ImageScale 

The scaling value for the middle part is specified here.  This 
scaling helps to achieve subpixel precision in the estimation 
during the autocorrelation calculation. 

• CorrelationPeakThreshold 

This defines a threshold value (scaled from 0 to 1) below 
which the correlation peaks are removed when determining 
the offset with the highest correlation. 

• VecNumSamples 
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This specifies a 1-D signal interpolation using cubic splines to 
estimate the location of a correlation peak. 

 
Scale factors:  

All values to be optimized should be similarly scaled to ensure good 
convergence. Therefore, scaling factors can be specified to be ap-
plied to the different values to be optimized.  If a particular parameter 
in the ScaleFactors section is specified as IsActive="true" and an ini-
tial value is specified for this term, the initial value should be scaled 
with the correct scaling factor.  For example, if <FocalLengthScale 
IsActive="true">1000</FocalLengthScale> is specified, a value speci-
fied for FocalLengthX or FocalLength Y should be divided by 1000, as 
it is assumed that it must be multiplied by 1000 to obtain the actual 
value. 
 

• AngleScale 
This specifies a scaling factor that is applied to the estimated 
angles to ensure that they remain within an ideal range for the 
optimizer. 

• RadialDistortionScale 
This specifies a scaling factor that is applied to the radial dis-
tortion coefficients to ensure that they remain within an ideal 
range for the optimizer. 

• TangentialDistortionScale 
This specifies a scaling factor that is applied to the tangential 
distortion coefficients to ensure that they remain within an 
ideal range for the optimizer. 

• FocalLengthScale 
This specifies a scaling factor that is applied to the Fo-
calLengthX and FocalLengthY values to ensure that they are 
within an ideal range for the optimizer. 
 
 
 

• PrincipalPointScale 
This specifies a scaling factor that is applied to the values of 
PrincipalPointX and PrincipalPointY to ensure that they are 
within an ideal range for the optimizer. 
 

Analysis parameters:  

• Alpha and beta angle 
These angles describe the alignment of the diffractive optical 
element to the incident expanded and collimated laser beam. 
These values are determined during the optimization process 
and are part of the output parameters. However, they can be 
set to zero for troubleshooting purposes, for example. These 
angles are specific to Geocal and are not directly related to 
the calibrated camera. 

• Angle Omega (roll), Phi (pitch), Kappa (yaw) 
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These angles describe the alignment of the test specimen to 
the diffractive optical element. 
These values are determined during calibration and output as 
a result. However, they can be set to a fixed value for trouble-
shooting purposes. 

• Radial Distortion Coefficients 1-15 
The radial distortion coefficients that model the distortion are 
referred to below as k1 , k2 , ...  : 
 

xdistorted = x(1 + k1 *r2 + k2 *r4 + ... + k15 *r )30 

ydistorted  = y(1 + k1 *r2 + k2 *r4 + ... + k15 *r )
30 

 
These values are determined during calibration and output as 
a result. However, they can be set to a fixed value for trouble-
shooting purposes. 

• Tangential Distortion Coefficients 1+2 
The tangential distortion coefficients model this type of distor-
tion and are referred to below as p1 , p2 : 
 

xdistorted = x + [2p1 xy + p2 (r² + 2x²)] 

ydistorted = y + [p1 (r² + 2y²) + 2p2 xy] 
 
These values are determined during calibration and output as 
a result. However, they can be set to a fixed value for trouble-
shooting purposes. 

• Focal Length X and Y 
The focal length values of the test specimen in X and Y are 
determined during calibration and output as a result in pixel di-
mensions. However, they can be set to a fixed value for trou-
bleshooting purposes. 

• Skew coefficient 
The skew coefficient is set to 0 by default. It is not equal to zero if 
the image axes are not at right angles. 

• Principal Point 
The main point describes the point at which the optical axis of 
the camera lens intersects with the image sensor. It is deter-
mined during calibration and output as a result. However, it 
can be set to a fixed value for troubleshooting purposes. 
 

To make changes to the default configuration file, open it in a text edi-
tor. It is recommended that you make a copy of the standard version 
before editing it. 
 

Version: 
<Configuration Version="3" Description="Translation"> 
When installing the latest software, the latest configuration file is al-
ways installed as well. 
 
 
Edit Control Parameters: 
Example: 
<MinF Use="false">0.1</MinF> 
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The "Use" flag indicates whether the following value is used for the 
calibration procedure. If it is set to "false", it is not used and the de-
fault value is used instead. To use a user-defined value, write "true" 
instead of "false" and change the value ("0.1" in this example) as re-
quired. The new value will be used for each calibration until you set 
the "Use" flag back to "false". 
 
 
Edit Analysis Parameters: 
Example: 
<Alpha IsInvariant="false" UseAsStartValue ="false" Unit="De-
gree">0</Alpha> 

 
The "IsInvariant" flag specifies whether the following value is calcu-
lated during calibration or set to a fixed value. If it is set to "false", the 
value is calculated during each calibration. To set it to a fixed value, 
write "true" instead of "false" and change the value ("0" in this exam-
ple) as desired. The new value is used for each calibration until you 
set the "IsInvariant" flag to "false" again. 
You can use the "UseAsStartValue" flag to specify a start value for 
the analysis. If you set the flag to "true", the following value is used as 
the start value. If you set the flag to "false", the default value is used. 
The default value is always "0". By default, the center of the image is 
used for the principal point.  
If the "IsInvariant" flag is set to "true", the "UseAsStartValue" flag is 
ignored. 
 
 
 
 
Information on the supported directory models: 
 
Example of use with six radial distortion coefficients released for opti-
mization.  

  NOTE 

We recommend that you do not set the number of dis-
tortion coefficients higher than absolutely necessary, as 
an unnecessarily high number can lead to "over-
sampling" artifacts. 
 
 The usual default values for each distortion model are 
stored in the respective configuration file included in 
the installation. 
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1. EVEN BROWN MODEL 

 
The radial distortion coefficients, which model the distortion, are de-
scribed as follows  : 
 

xdistorted = x(1 + k1 *r2 + k2 *r4 + ... + k15 *r )30 

ydistorted  = y(1 + k1 *r2 + k2 *r4 + ... + k15 *r )
30 

 
 
 
2. FISHEYE MODEL 

 
The radial distortion coefficients, which model the distortion  , are 
designated as follows: 
 
θd = θ(1 + k1 *θ2 + k2 *θ4 + k3 *θ6 + k4 *θ )8 
 
 
 
 
 
 

3. CUSTOM MODEL 2 (DIVISION MODEL) 
 

 
 
The radial distortion coefficients that model the distortion  are desig-
nated as follows: 
 

xdistorted = x / (1 + sign(k )*k *r11
2 + sign(k2 )*k2 *r4 +...+ sign(k8 )*k *r )15

30 

ydistorted= y / (1 + sign(k )*k *r11
2 + sign(k2 )*k2 *r4 +...+ sign(k8 )*k *r )15

30 
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10.3 Artificially generated sample images 

Four sample images are available, which you can find in the following 
directory  
 
 C:\Program Files\Image Engineering\GEOCAL 1.x.x\samples 
 
 These images were created synthetically with the following parame-
ters 

Focal lengths [fx,fy]: 3030 
Skew: 0 
Tangential coefficients: 0 
Principal point [u0,v0]: [960, 752] 
DOE parameters [grating constant, wavelength]: [43.9, 0.6328] 
DOE and camera angles [alpha, beta, omega, phi, 
kappa]: 

0 

 

Image Model Radial coefficients[1 to 6] 
simulate_model2.png CUSTOM_MODEL_2 [1, 1, 1, 1, 1, 1] * 10-6 

simulate_modelf.png FISHEYE_MODEL [0.5, 0.5, 0.5, 0.5, 0.5, 0.5] 
simulate_modele.png EVEN_BROWN_MODEL [0.5, 0.5, 0.5, 0.5, 0.5, 0.5] 

 

To familiarize yourself with the different models and the interactions 
of the parameters in the configuration files, you can use the default 
configurations specified for each model and run the GEOCAL soft-
ware on the simulated images.  
You should get results that are very close to those used to create the 
simulated images. 

10.4 Loading images for analysis 

Click on "File" → "Load images" (Ctrl+O) → navigate to the folder 
containing the images → select one or more images and click on 
"Open". 

In its current state, the software supports the analysis of 8bit and 
16bit images. 

The following file types are supported (de-bayered images): .TIFF, 
.JPG, -BMP, . PNG 

The images to be analyzed must be recorded in such a way that the 
dot grid completely fills the sensor. 

10.5 Delete images 

Right-click on the selected image in the list to open a context menu 
containing a delete option 
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10.6 Image analysis 

Fig. 10.6.1: Software user interface overview 

• Image selection: Select an image from the list in the "Image 
Data" area (1). The image is then displayed in the "Image & 
Results" area (4) on the "Image" tab. You can zoom in and out 
of the image using the mouse wheel. 
 The zoom is centered around the position of the mouse 
pointer. 

• Point detection: Detect the light points in the image by click-
ing on the "Detect" button in the "Detection & Analysis" section 
(2). 

Detection is complete when the progress bar at the bottom of 
the window (5) reaches 100%. By clicking on "Show detected 
Grid" under the "Image" tab, you can display a visualization of 
the detected light points. 

If the automatic detection fails, you can make a manual ROI selection 
by ticking the box in the "Detection & Analysis" section (2). Five pre-
set ROIs will then appear in the visualized view. 

The size and position of these ROIs can be adjusted by clicking and 
dragging. 

An ROI must be positioned on the zeroth diffraction order (the bright-
est point in the center of the grid). 
 Adjust the size of the ROI so that it contains only one point. 
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The four remaining ROIs must be positioned on the points closest to 
the zeroth diffraction order, i.e. the points at the top, bottom, left and 
right. These four ROIs must also contain only one point. In addition,  
the individual ROIs should not overlap significantly. See Figure 10.6.2 
below for reference. 

Fig. 10.6.2: Manual point detection 

• Analysis: After detection, the actual analysis can be carried 
out. Click on the "Analyze" button in the "Detection & Analy-
sis" section (2) to start the calibration. The progress bar (5) 
shows when the calibration is complete. 
 
 The time required for calibration may vary slightly depending 
on the number of points detected. 

• Calibration results: The results are listed under the "Result 
table" tab in the "Image" section (4). The RMSE of the calibra-
tion is also included in the result table. You can clear the re-
sults table if required by clicking on "clear table". Under the " 
Distortion curve"  
tab, you will also see a graphical visualization of the camera 
distortion determined (geometric distortion vs. field). 

• Generate HDR image: Specify the exposure times for the in-
dividual HDR image data (6). Select an algorithm (Mertens, 
Debevec or Robertson) for the generation and click on the 
"Generate HDR" button. An "HDR" subfolder is created in the 
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HDR image data folder in which all generated images are 
saved. 

10.7 Save results 

You have the option of saving your results in either an XML or a CSV 
file. If you have analyzed several images, select one or more images 
whose results you would like to save from the list in the "Image data" 
section. 

Then click on File → Save result → Save XML or Save CSV → navi-
gate to the desired storage location → click on Save 

If you have selected several images, all results are saved in a CSV or 
XML file. 

10.8 Export detected point grids 

You can export three different grids, which are saved in CSV files. 
Two files are saved for each exported grid, one for the x-coordinates 
and one for the y-coordinates. 

To export a grid, click on File → Save grid → select the desired grid 
→ navigate to the desired storage location → click on Save. 

Available grid types: 

• Detected grid: Describes the grid type that contains the de-
tected light points. 

• Reprojected raster: Describes the raster type that contains 
the reprojected light points used to determine the distortion. 

• Undistorted reference grid: Describes the grid type that con-
tains the points of the reference grid without lens distortion. 
This raster only contains the distortion given by the DOE 
physics and the extrinsic and intrinsic parameters determined. 

10.9 Visualization of the results data 

Various visualization types are available: 

10.9. 1Grid view 

After a successful analysis, the detected and newly projected points 
are displayed on the original image. Zoom into the image to get a bet-
ter view. The dots have a size of one pixel. 
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10.9. 2Distortion curve 

The curve is calculated from the distortion coefficients and describes 
the course of the determined distortion of the lens from the optical 
axis to the outer edge of the image (Field 0... 1 ). 

10.9.3  "Quiver Plot" 

The quiver plot shows the direction of the deviation. The respective 
arrows show how the detected points are arranged in relation to the 
reprojected points. 

10.9.4 "2D Color Scatter" 

This display shows a grid of color-coded dots, with each dot repre-
senting the distance ratio between detected and reprojected dots. 
The scale on the right shows the individual color coding. 

10.9.5 Histogram 

Two different histograms are displayed . The first histogram contains 
the successfully detected diffraction points as a function of the radius. 
The values start at zero (main point) and run along the image diago-
nal up to the image corner (one). 

The second histogram contains the successfully detected diffraction 
points as a function of the angle. The values are based on a straight 
line that runs from the main point to the right edge of the image. The 
angles increase in an anti-clockwise direction. 

10.10 Logging 

The browser displays the logging data for each action in the "Log-
ging" section of the user interface. This can be helpful if errors occur. 
The software also has a status bar at the bottom where error mes-
sages from the API are displayed directly. 

 

10.11 Exit 

Click on File → Exit (Ctrl+Q) to exit the software or close the window. 
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11 Troubleshooting 

11.1 Procedure in the event of faults or errors 

In the event of a malfunction, take Geocal out of operation immedi-
ately. 

To do this, pull the mains plug out of the socket. 

Then please contact Image Engineering Support. 
 (See chapter 14.1 - Service addresses) 

11.2 Fault and error messages 

Below you will find some examples of possible errors with suggested 
solutions. 

Observation Possible error Possible solution 

Control LED 
on the back 
does not light 
up 

Power supply inter-
rupted,  
defect in the device 

Check all plug connec-
tions. If the error persists, 
test a different desktop 
power supply or contact 
Image Engineering Sup-
port 

No laser light 
is emitted 

Laser switched off, 
laser holder inter-
nally misaligned due 
to fall or transport 
damage 

Check the position of the 
toggle switch on the back 
and the plug connection to 
the power supply unit. If 
the error persists, contact 
Image Engineering Sup-
port 

 

11.3 Eliminate faults 

Faults that cannot be rectified without opening the device may only be 
rectified by specialist personnel trained by Image Engineering. 

Please contact our support team. 
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12 Care notes and recycling 

12.1 Care 

If the housing or DOE of the Geocal is dirty, clean it with a dry cloth. 

  NOTE 
Make sure that you always use a clean cloth to clean 
the DOE to avoid scratches, which can otherwise lead 
to disturbing visual effects. 

 

 

 

12.2 Disposal and recycling 

At the end of its service life, Geocal must be disposed of properly. 
The device must not be disposed of with household waste. 

 

 

 

 

 
If you wish to dispose of Geocal, please return the equipment to Im-
age Engineering. 

If you need assistance with the return shipment or would like a return 
slip, please contact one of Image Engineering's service addresses. 
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13 Technical data 

Overview 

 

Product name GEOCAL / GEOCAL XL / GEOCAL IR 

Principle DOE-based, geometric calibration of digital cameras 

 
Features  

Hardware 

Diffractive Optical 
Element (DOE) 

Creates an evenly distributed grid of light points projected 
from infinity 

DOE output 
window 

GEOCAL / GEOCAL IR: Ø 77 mm  
GEOCAL XL: Ø 155 mm 
 
 (Diameter of the camera lens ≤ exit opening ) 

Compatible FoV 
approx. 30 - 120° (larger angles possible, depending on 
the camera. Please contact us for details). 

Dimensions 
(L x W x H) 

GEOCAL / GEOCAL IR: approx. 575 mm x 144 mm x 170 
mm 

GEOCAL XL: approx. 850 mm x 244 mm x 270 mm 

Mounting points 

GEOCAL / GEOCAL IR: 3 x M5 x 0.8 internal thread in 
the base plate 

GEOCAL XL: 10 x M5 x 0.8 internal thread in the base 
plate 

 

Illumination 
(WARNING: Visible or invisible laser radiation!)       

Light source Frequency-stabilized laser diode 

Wavelength 
GEOCAL / GEOCAL XL: 633 nm 

GEOCAL IR: 935 nm 

Optical power 5 mW 

Laser class  
(diode only) 

3B 

Laser class 
(GEOCAL) 

1M 

Service life >20.000h 

Warm-up time Not required 

 

Software 

System 
requirements 

PC with Windows 7 operating system (or newer) , 

USB connection 

Functions 
• Load multiple recordings 

• Show recordings 
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• Perform calibration 

• Display detected point grid as overlay 

• Various result visualization methods 

• Results export (CSV and XML)  

• Export of coordinates of detected points (CSV) 

Output data 
Extrinsic and intrinsic camera data, orientation of the DOE 
to the laser 

API (C++) Optionally available separately 

 
General description of the hardware 

Power consumption Pmax = 2 W at 5VDC 

Connections USB type B 

Weight 
GEOCAL / GEOCAL IR: approx. 4.5 kg 

GEOCAL XL: approx. 9 kg 

Temperature range  15 - 35 °C 

 

Requirements for the Device Under Test (DUT) 

Max. Dimensions 
GEOCAL / GEOCAL IR: max. diameter of the lens: 77 mm 

GEOCAL XL: max. diameter of the lens: 155 mm 

Usable FoV 
Approx. 30 - 120° (larger values possible, depending on the 
camera. Please contact us. 
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14 Appendix 

14.1 Service addresses 

For support requests, please contact us directly:  
support@image-engineering.de  
 

Europe  
Image Engineering GmbH & Co KG  
Im Gleisdreieck 5  
50169 Kerpen  
 
Mon-Fri: 9:00 a.m. to 5 p.m. (CET)  
 
Tel: +49 2273 99 99 1-0  
 
Email: info@image-engineering.de  

USA  
Image Engineering USA, Inc.  
3079 Harrison Avenue, Suite 6  
South Lake Tahoe, CA 96150  
 
Mon-Fri: 8 a.m. to 6 p.m. (CT)  
 
Phone: +1 408 386 1496  
 
Email: sales@image-engineering.us  

China  
Shenzhen Image Engineering Optoelectronic Equipment Co, Ltd (IE 
China Subsidiary)  

深圳艾宜光电设备有限公司 (IE中国全资子公司）   

Room 1508, Chengshi Shanhai Pingji Center,  
Pingxin North Road No.51, Pinghu Street,  
Longgang District, Shenzhen City, China  

深圳市龙岗区平湖街道平新北路51号城市山海平吉中心15楼1508室  

 Mon-Fri: 9 a.m. to 6 p.m. (CST)  

中国子公司工作时间：每周一至周五 上午9点-下午6点  

 
 Phone  
+86 158 8961 9096  
 
Email: leon.xiao@image-engineering.com 
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Image Engineering GmbH & Co KG 

 

Im Gleisdreieck 5  

DE-50169 Kerpen 

 

Phone: +49 2273 99 99 1-0 

Fax: +49 2273 99 99 1-10 

E-mail: info@image-engineering.de 

 

 www.image-engineering.de 

All contents of these operating instructions, in particular texts, photographs and 

graphics, are protected by copyright. Unless expressly indicated otherwise, the 

copyright lies with Image Engineering GmbH & Co KG. 

 

 The Image Engineering GmbH & Co KG reserves the right to change this docu-

mentation and the descriptions, dimensions and technical data contained therein 

without prior notice. 

 We would like to point out that these operating instructions may only be repro-

duced for internal purposes and without any changes to the content. The con-

tents may not be made available to third parties and may not be used for pur-

poses other than those for which they were intended.  

© Copyright remains with Image Engineering GmbH & Co KG. 
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